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Mp3 Players

Yes, the Geek Squad from Best Buy are coming.
They will explain all there is to know about Mp3
players.

Should you get an iPod, a SansaFuse, or another
brand and what is the difference among the various brands?

Do you own a Mp3 player or thinking of buying one?

Do you know what they are capable of?

How do you load the darn thing and how you do make it
do what you want it to?

If these are some of your questions, make sure to mark the date and attend
the meeting on October 6. g

On page 2 [Editorial Notes] you’ll find one of the ways I use my computer. We’d like to hear
how you use your computer. Do you keep a budget using Excel? Do you have an album of
photos? Do you just surf the Web? Are you into games? Whatever keeps you pounding those
computer keys, we’d like to know about it. Send us a paragraph or a full page—in Word, Word
Perfect, or plain .txt format and we’ll publish it in the newsletter. We can include your name, if
desired, or keep it anonymous if you’d prefer. Just let us know. Send to editor@mvpcug.com. 

mailto:editor@mvpcug.com


Stay connected . . . to the MVPCUG
Mohawk Valley PC User Group, Inc.
$25 for initial sign-up  - $20 for renewal

  Name___________________________________________________
  Address_________________________________________________
  City__________________________________________________NY
  Zip___________________Phone_____________________________
  E-mail___________________________________________________

Please mail this application with a check payable to MVPCUG to
M V P C U G
PO Box 586

Marcy NY 13403-0586
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The MVPCUG EXPLORER is published monthly from September

through June by the Mohawk Valley Personal Computer User Group,

Inc.(MVPCUG), PO Box 586, Marcy NY 13403-0586.

Opinions expressed herein are the writers and are not reflective of

the MVPCUG, nor are they considered substantiated by inclusion in

this newsletter. All articles are copyrighted by their respective authors

but may be reprinted by other User Groups provided credit is given to

the author and this publication.

The. MVPCUG was founded in 1981 by individuals interested in

IBM compatible computers. This non-profit organization consists of

volunteers whose expertise range from novice to professional.

Regular meetings are held on the first Tuesday of the month at

6pm, usually at the Whitesboro High School, Route 291, Marcy NY.

A typical agenda consists of discussion of business affairs and a

demonstration of computer related products.  Meetings are open to the

public.

Initial membership fee for an individual is $25. Annual renewal
dues are $20.
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Jerry Finkelstein. . . . . . . . . . . . . . . . . . . 797-5296
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NEWSLETTER STAFF
Jerry Finkelstein. . . . . . . president@mvpcug.com
Donna Gorrell. . . . . . . . . . . . editor@mvpcug.com
John Hunter.. . . . . . . . . johnhunter@mvpcug.com

Editorial notes . . .
   Remember when we were kids and
back to school meant writing an
essay on what we did on summer
vacation? Well, I spent the summer
working on my genealogy since most
of the time was either too wet or too cold to be outside.
   What a wonderful thing computers have brought to
me—access to the world. My family is from Illinois and
Bill’s family started in Pennsylvania and moved to Ohio.
So we have no local ancestors. Twenty years ago I would
have been forced to go to libraries or court houses in the
areas where these ancestors lived. Now I am fortunate
to be able to sit at my computer and correspond with
relatives all over the country—sending photos and
documents back and forth. I’m also able to research
census forms and birth and death certificates, all online.
   Hopefully your computer serves you well and that you
find it helps make your life easier.

Meeting Agenda

5:30. . . . . . . . . . . . . . . . Meet and Greet
6:00. . . . . . . . . . . . . Business Meeting
6:30. . . . . . . . . . . . . . . Program, Part 1
7:10. . . . . . . . . . . . . . . . . . . . . . . . Break
7:20. . . . . . . . . . . . . . . Program, Part 2
8:15. . . . . . . . . . . . . Drawing for Prizes
8:30. . . . . . . . . . . . . . . . . . Adjournment
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The MVPCUG general meeting was held at the
Whitesboro HS cafeteria. President Jerry Finkelstein
called the meeting to order at 6:05 PM. There were 23
persons in attendance.

BUSINESS MEETING
Jerry started the meeting by giving a brief talk on

the new M/S Windows 7 system. He also cited that
one day, in the future, most of the daily newspapers
will become a pay for viewing on our computers. Next
Jerry opened a discussion and description on Flash
Drives also known as Thumb Drives. He demonstrated
on using the Flash Drive and its effectiveness. He
answered many questions from the members on the
practicality use of this small device.

Jerry then asked Bill to give a treasury report
covering for the month of 6/01/09 to 8/31/09, to the
attending members. Those that are interested in the
full treasury report can check either with the
secretary or Bill Gorrell.

PROGRAM
For tonight’s program “Ask the Gurus” , we were

treated with three experts, Chris Urban, Greg
Hasseler and Nick Gasparovich. Many questions were
asked by the members and the gurus came
to the rescue with their answers. Chris Urban handed
out sheets on tips to speed up your windows
PC. He also stressed the importance of backing up
your data. He especially recommended getting
Carbonite as the best place to store your important
files. It was an interesting, informative and
helpful session.

DOOR PRIZES
[Furnished with club funds]

Flash Drive 4gb. . . . . . . . . . . . . . . . . George Purpura
Photo Paper-4X6.. . . . . . . . . . . . . . . . Donna Gorrell
USB 2.0 Cable.. . . . . . . . . . . . . . . . . . . . . . Jim Pease

[Donated by Rod St. Clair]

Book-Project Mngt. . . . . . . . . . . . . . . . Bill Brunnett
12-CD Cases. . . . . . . . . . . . . . . . . . . . . . Don Pianka

[Donated by Que Publishing]

Google-Pedia Book. . . . . . . . . . . . .  Ed Sajdzikowski

[Donated by Microsoft]

Ball. . . . . . . . . . . . . . . . . . . . . . . . . . . Richard Eades
[Donated by Pearson Education]

Facebook ERA-Book. . . . . . . . . . . . . . Rod St. Clair

The meeting adjourned at 8:17 PM.
Helen Russell, secretary g

  Minutes of September 10, 2009
— HRussell, Secretary  

Your hint, or tip, or review of a program
could appear here next month. Send an
article that you feel would be of interest
to other club
members to
editor@mvpcug.com
and you might gain
an extra door prize
ticket.

Rick Broida of PCWorld says it’s possible
to tweak the Start menu so that options
like Documents, Pictures, Computer, and
Control Panel produce fly-out menus when
you mouse over them. This is an easy way
to access your files.
   With fly-out menus, mouse over the
desired option, then choose the item you
want. Here’s how to do it. [This example is
for Vista, but it’s virtually identical in XP. A
few of the Start menu items have slightly
different names.]
   1. Right-click the Start button, and

then click Properties.
   2. In the Start Menu tab, click the

Customize button. [XP users should
then switch to the Advanced tab.]

   3. You’ll see entries marked
Computer, Control Panel,
Documents, Games, Music, and so
on. For any or all of them, enable
Display as a menu.

   4. Click OK twice to exit.
Now, when you go to Start, you’ll see that
these items have little arrows. Mouse over
one [or click it] and you’ll see the
associated options in a fly-out menu.

mailto:editor@mvpcug.com


  Tips to Speed-up Your PC
— by Chris Urban   
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1.  Start by cleaning out your Startup folder . . . find it
in C:\Documents and
Setting\username\StartMenu\Programs\Startup,
where username is your Windows logon name.

A. Delete the shortcuts of any programs you
don’t want to run on start-up. As with any
shortcuts, when you delete them, you’re
deleting only the shortcut, not the program
itself.

B. You can also clear out the start-up items by
going to Start | Programs | Startup, then right-
clicking items you want to remove.

C. Check the Startup folder once a month.

2.  Run MSCONFIG . . . specific instructions are
found at the following link:
http://netsquirrel.com/msconfig

3.  Remove all spyware from the computer by using
free programs such as AdAware by Lavasoft and
Malwarebytes. Once these programs are installed, be
sure to check for and download any updates before
starting your search.

A. Open a browser and go to http://lavasoft.com
and click the green “Download AdAware
Free” button in the upper right corner.

B. Follow the prompts for installation . . . update
and run once a week.

C. Open a browser and go to
http://malwarebytes.org/ and click the blue
“Download Free Version” button on the left.

D  Follow the prompts for installation . . .
update and run once a week.

4.  Disable the file indexing.
A. Open My Computer [double click the “My

Computer” icon]
B. Right-click on the C: Drive
C. Select Properties
D. Uncheck “Allow Indexing Service to index

this disk for fast file searching”
E. Apply changes to “C: subfolder and files”, and

click OK
Note: if a warning or error message appears [such as
“Access is denied] click the “Ignore All” button.

5.  Run a disk cleanup once a month.
A. Double-click the My Computer icon
B. Right-click on the C: Drive
C. Select Properties
D. Click the Disk Cleanup button—it’s just to the

right of the Capacity pie graph—and delete all
temporary files

6.  Defragment your disk . . . here’s how by using the
“Properties” of “Your Local Disk”

A. Open My Computer [double-click the “My
Computer” icon]

B. Right-click the local disk volume that you want
to defragment and then click Properties

C. On the Tools tab, click Defragment Now
D. Click Defragment . . . run once a month

7.  Clean your registry by using a freeware application
such as:
http://download.cnet.com/TweakNow-
Regcleaner/3000-18512_4-
10262639.html?tag=1ia:rcol

[or use this link: http://tinyurl.com/lr6a9e ]
Remember to backup your files before doing anything
to your Registry. g

   Chris Urban, along with Nick Gasparovich and
Greg Hassler, all from from SUNYIT, appeared
on the "Guru" panel at the September meeting.
They answered our many questions and Chris
came prepared with a hand-out sheet in
anticipation of the question of how to speed up
our computers. He graciously agreed to allow us
to print the information so that all of us can
benefit. He agreed to the addition of the last
sentence which does not appear on the printed
copy he handed out. He did preach throughout
the meeting the importance of backing up your
data files. Chris, Nick and Greg all use the
online backup service from Carbonite, available
at: http://www.carbonite.com/. There is a fee for
this service [currently $54.95 per year], but all
three of these gurus highly recommend it.

   As always, a Thank You note is sent to each
presenter after the meeting. This is just part of
the contact and follow up that are jobs done by
the volunteers of this club.

http://netsquirrel.com/msconfig
http://lavasoft.com
http://malwarebytes.org/
http://tinyurl.com/lr6a9e
http://www.carbonite.com/
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Some nifty add-ons for browsers:

IE7Pro
Go to http://tinyurl.com/l4ylk8 to download this add-
on for Internet Explorer. It is an ad blocker, tab
manager, can automatically scroll Web pages,
automatically refresh pages, and recover if IE crashes. 
Read the reviews at the bottom of the page before
downloading.

Google Preview
Go to http://tinyurl.com/2zbubs to download this
Firefox add-on. A thumbnail of each site is given in
the Google search results. You can then see if it’s a
site you want to go to. The add-on also offers site
thumbnails when you search using Yahoo.

MiniMap Sidebar
Go to http://tinyurl.com/2963qc to download this
Firefox add-on. Open it as a Firefox sidebar, then drag
and drop address names or links to it, and a map of
them will open right in the sidebar. You have your
choice of map services including Google Maps, Yahoo
Maps, and others. You can then zoom in or out, get
directions—pretty much anything you can do on the
mapping site itself. In fact, you can even do more
because Mini Map Sidebar includes some nice extras
such as traffic information. Read the “more about this
add-on” by scrolling to the bottom of the page.

FireFTP
Go to http://fireftp.mozdev.org/ to download this add-
on for Firefox. FTP stands for File Transfer Protocol
which is needed to transfer files from your computer
to your web site. FireFTP is a free, secure, cross-
platform FTP client for Firefox which provides easy
and intuitive access to FTP servers. Once installed,
FireFTP appears in the Tools menu. Click it and a new
FTP tab opens up, offering a simple two-pane system
that lets you easily copy files between your desktop
and your remote site.

FeedsPlus
Go to http://www.enhanceie.com/ie/feedsplus.asp to
download this add-on for InternetExplorer7. If you

like the RSS blog reader built into IE 7, you need this
program. It adds two useful new features— the ability
to read all of your feeds from a single location, instead
of having to read a feed at a time, and it alerts you
when your favorite feeds have new content. This
program does not work with InternetExplorer8. g

~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~

MICROSOFT TIPS

WORD 2007
Add or Remove Styles from the Quick Style Gallery

The Styles gallery on the Home tab in Word 2007
includes several built-in paragraph and character styles
by default, such as Normal style, Heading styles 1 and
2, and Title. However, you can customize that gallery
for any document or template to include just the
paragraph and character styles you need to access
most quickly. To display the Styles pane, click the
dialog launch icon in the lower-right corner of the
Styles section (or press CTRL+SHIFT+ALT+S). To
remove a style from the Quick Style Gallery,
right-click the style name where it appears in the
gallery, and then click Remove from Quick Style
Gallery. To add a style in the Styles pane to the Quick
Style Gallery, right-click the style name, and then click
Add to Quick Style Gallery. (Note that, if the style is
already in the gallery, the option to remove the style
from the gallery also appears here.) You can also add
or remove a style from the Quick Style Gallery
through the Add to Quick Style Gallery check box in
the Create New Style... or Modify Style dialog boxes.

EXCEL
Format Chart Elements Just Like Shapes

In Excel 2007, charts have as much data-crunching
power as ever. They’re also part of the new Microsoft
Office graphics engine, so you can format charts with
the same flexibility as other Microsoft Office drawing
objects, such as shapes. To apply a style of formatting
to the entire chart, on the Chart Tools Design tab,
select an entry from the Chart Styles gallery. Or to
apply custom formatting, select a chart element (such
as a data series), and then click the Chart Tools
Format tab for the option to apply shape styles, fill,
outline, or effect formatting. From the Chart Tools
Format tab, you can also apply WordArt formatting to
the text of selected chart elements, such as the legend,
axis labels, and data labels. g

     This ‘n That . . .
—Donna Gorrell     

http://tinyurl.com/l4ylk8
http://tinyurl.com/2zbubs
http://tinyurl.com/2963qc
http://fireftp.mozdev.org/
http://www.enhanceie.com/ie/feedsplus.asp
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Who Are You? And What Are You Doing With
My Money?

N
ext to spam alerts and various web attack
warnings, identity theft is probably the biggest
worry we face related to our computers and

our personal financial lives. Horror stories abound of
people finding themselves in debt for items they never
purchased, checks they never wrote and credit cards
they never authorized. Many companies, for a fee,
offer to help you either prevent identity theft or to
help dig your way out of the financial chaos identity
theft causes. Should this happen to you, you don’t
have to worry or pay additional money to clean up the
mess. The following web site provides free advice and
assistance to those facing identify theft issues. 
IdentityTheftResourceCenter.org provides many
services to those in need. Click on the URL and the
homepage pops up. Along the right margin, current
identity theft news scrolls up: 372 data breaches to
date in 2009, for example. 

Across the top, various buttons will lead you to
Data Breaches, Victim Resources, Consumer
Resources, State & Local Resources, Scams &
Consumer Alerts and Teen Space. Down the left side
of the page, buttons appear listing About ITRC, ITRC
Sponsors, Business Solutions and so on with
additional links to Spanish and Chinese language
resources as well. 

At the bottom of the Homepage, a “Help I’m an
Identity Theft Victim” appears. Click the button and
specific advice comes up telling you what to do first. 
The site stresses that help is free and you are able to
talk to a staff person by telephone or email for
individual assistance. The site also provides fact sheets
listing the steps you must take to clear up the financial
mess and letter templates you may use to contact
businesses, credit bureaus and so on. So, if help is
needed, help is available. Good luck.

Drug Assistance Programs
We all know about the high cost of prescription

drugs. We also know that many individuals lack the
resources to pay for the drugs that keep them well.
There are several web sites that will provide you with
information that may help lower your prescription
drug costs. Although many assistance programs have
income requirements, don’t think that you can’t

qualify for assistance because your income is too high.
Many agencies consider requests for help on an
individual basis. Partnership for Prescription,
pparx.org is a network of drug companies and
professional medical organizations that are able to
match you to more than 475 public and private
patient/drug assistance programs that provide drugs at
low or no cost.
     At my visit, the home page provided an 888
telephone number that you may use to call for
assistance. When I clicked on the patient resource
button, up came a page listing helpful sites for
medicare drug coverage, patient assistance programs
where you search by drug name, company name or
program name, co-payment programs, a free or low
cost clinic finder and drug savings cards. Most large
pharmacy chains have low cost drug programs as do
some retail chains such as Wal-Mart and Wegmans.

The Co-payment programs list begins with the
American Kidney Fund and goes through Patient
Services Inc. A thumbnail explanation of each
provider indicates what will and will not be provided.

Other helpful sites include: RX Assist, rxassist.org.
This site provides databases you may search for
patient assistance programs. Another helpful site is
NeedyMeds at needymeds.org. This site also provides
lists of drug assistance programs as well as links to
state sponsored programs.

The pharmaceutical industry also provides direct
assistance through the site, Together Rx Access, 
togetherrxaccess.com. Income levels are $45,000 for
individuals, $60,000 for a family of two and $105,000
for a family of five. 

For those taking generic drugs, there are several
helpful sites. These include Rx Outreach at
rxoutreach.com and Xubex Pharmaceutical at
xubex.com.  These sites provide good deals on generic
drugs with no income qualification.

For price- conscious shoppers who wish to cut to
the chase, click on destinationrx.com and register for
free. Type in the drug you are looking for and click on
“Compare Pharmacy Prices” for a cost comparison of
online, mail-order and local pharmacies. The
comparison provides the lowest and highest cost for
each individual drug.

Since we all have computers, these sites are easy to
access. What do the poor without computer access or
the computer phobic do to save money on drugs?

Until next time . . . g

   Sites to Visit on the ‘Net
— by John Hunter    

http://Www.IdentityTheftResourceCenter.org
http://www.pparx.org
http://www.rxassist.org.
http://www.needymeds.org.
http://www.togetherrxaccess.com
http://www.rxoutreach.com
http://www.xubex.com.
http://www.destinationrx.com
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.. . . that holding down the Ctl key and using the
mouse wheel in Firefox will cause the web page to
zoom in or out?

.. . . that you could also open a new link by clicking it
with the mouse wheel? If you have programmed your
mouse to do something special with the wheel this
trick might not work. The default in Firefox, Internet
Explorer, and Google Chrome is to open the clicked
link in a new tab.

.. . . that there is an easy way to make a record of the
files in a folder? Chose the folder you want and select
all [Ctrl-A], then right click any file. Choose Send To
and select Mail Recipient. This opens your default
mail program. The list of files should show up in the
body of an email, which you can then copy and paste
into a word processing or any program you desire.

.. . . that you can find out the size of a folder and how
many files it contains? Select the item, press ALT-
ENTER and look on the General tab. Or, more
simply, right-click on the folder and choose
Properties, then look on the General tab.

.. . . that double clicking a Window’s Title Bar can
maximize the window? Double click it again and it
restores to original size.

.. . . that you could restrict the size of the photos or
graphics that you insert into a Word document?
Create a text box [click Insert and Text Box or Simple
Text Box in 2007]; copy and paste an image into it
and the image automatically resizes to fit within the
confines of the text box.

.. . . that Gmail is not an email client but a service?
Download Gmail Notifier [tinyurl.com/2egw2q], a
free application from Google that adds functionality to
Gmail. Notifier sits in your System Tray and will
check your Gmail account for new messages, alert you
when they arrive, display a synopsis of each message,
and sets itself as your default email client. Then when
you click on an email link, it opens Gmail in the
browser of your choice. It’s not supported on Vista
and you can’t use it with Google Toolbar. g

Everything gets easier. You never did have to
know much to use the computer in a very basic sort of
way: type out a document, do email, surf the Internet,
land on a Website. You need not touch-type, you can
use just two fingers, or one. Nowadays you don’t have
to weigh yourself down with a camera or two, an
video camera, a cell phone to make and receive calls, a
radio, an iPod, a laptop for movies and to keep you in
touch with the wide world of the Net. It’s all in one
gadget now, it looks like a cell phone to me. 

A friend of mine showed off his pictures of Spain
stored on his cell phone. A bit dark, somebody was
posing in front of a church, I think it was a church. I
think the person posing was my friend. Also on his cell
phone were pictures of his grandchildren. Twins, he
said. The pictures were small and the babies were tiny
itty-bitty things. You can hardly make them out. But
he said they were his grandchildren and because he is
my friend I believed him. He’s the kind of guy who
enjoys watching Ben Hur on his cell.  He also reads
books. On his cell. Not audio books but the kind you
use your eyes to read the words. On his cell. 

GPS is built in, so he’s never lost. He has a very
large family and loads of friends and he’s in touch with
them at least four or five times throughout the day. He
always seems to be telling them exactly where he is at.
And I wonder who, really, needs to know when I am
getting into the car, getting out of the car, what aisle
I’m in at the store. One of my friends always lets me
know when he’s in the driveway. I’ve noticed lately, at
the movie house, lots of people checking their cell
phones in the lobby, then again just before the movie
starts, then once more right after the movie ends. I
feel sure they are checking it again as they get into
their cars. If you ever watched the TV series, 24, you
know that there is no show without a cell phone. Just
about all the action takes place on the cell phone. Just
like real life.

Well, the cell phone is a way to keep in touch with
family, friends and, literally, with millions of strangers.
Just about everybody is on Facebook, and it seems
like everybody twitters. It’s now easy to have the
world at your fingertips. It was very interesting to
hear our guest speaker saying at our last general
meeting that he didn’t own a cell phone. Why not, I
asked. He said, “Because I don’t want to be found”. g

   Did You Know . . .
— Donna Gorrell   

   Byting Remarks
— Jerry Finkelstein   

http://www.tinyurl.com/2egw2q
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